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Introduction
This introductory chapter includes general helpful information about how to use this help system, how to contact onOne Software, how to install and access the
software, etc. It covers many of the foundation topics that you will need to understand to get started.
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Using the Help System
This user guide is html based and readable in most web browsers. On the left side, you will see a table of contents that make it easy to find the section you are
looking for. The table of contents is hyperlinked and will take you to the specified section by clicking on them. The main body of the page will show you the
content you have requested. Use the scroll-bar at the right to scroll down for additional content. You may see hyperlinks in the body text. They will be blue and
underlined. Clicking on one of these hyperlinks will take you to more relevant information.
You use the same forward and back buttons in your browser to navigate this user guide as you would a regular web page. You can even bookmark pages so
you can find them quickly later.
If you don't see what you are looking for in the table of contents, try the search field at the upper right. You can type in what you are looking for and an index
of pages will be created automatically that contain your search term.

Printing the Manual
You can print individual pages by pressing the Print button at the top of the page. A complete printable PDF version of this user guide is available in the user
guide section of the onOne website. This version may be downloaded and viewed when you do not have an internet connection. The PDF version may also be
installed on your tablet or eReader device for viewing off our computer.

Contacting onOne Software
At onOne Software, we value our customers and offer a variety of ways to be contacted.
• Visit our company website at:
www.on1.com

• For technical support please visit:
www.on1.com/support

on1, Inc.
15333 SW Sequoia Parkway Suite 150
Portland, OR 97224

© 20072015 onOne Software, Inc. All rights reserved. onOne Software is a registered trademark of onOne Software, Inc. The onOne Software logo are trademarks
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of onOne Software, Inc. Adobe, Photoshop, Photoshop Elements, Lightroom are either registered trademarks or trademarks of Adobe Systems, Incorporated in the United
States and/or other countries. Mac OS X, the Mac logo, iPhoto and Aperture are trademarks of Apple, Inc., registered in the U.S. and other countries. Microsoft, Windows
7, Windows 8 are registered trademarks of Microsoft Corporation. All other trademarks are the property of their respective owners. The activation system used
by onOne Software, Inc. is licensed under Patent No. 5,490,216. For a full list of license disclosures view the LICENSE.TXT file installed with the software.

Additional Help

Technical Support
Contact technical support at www.on1.com/support or by filing out a request form.

Knowledge Base
Search the Knowledge Base for common issues, tips & tricks, and compatibility questions.
Frequently Asked Questions
Check the list of Hot Topics on the onOne web site. This covers the most frequently asked questions.

Video Tutorials
Visit the onOne University for free online video tutorials and archived webinars. Many users find these to be the best and fastest way to get
started and learn new techniques.

System Requirements

Operating System
Processor
RAM
Hard Drive

Display
Optional Application
Integration
Other

Minimum

Recommended

Mac OS X 10.8, 10.9, 10.10
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit only
Intel Core 2 Duo, Xeon or better
processor(s)
8 GB RAM

Mac OSX 10.9, 10.10
Windows Windows 7 or Windows 8
current maintenance releases, 64 bit
Quad-core Intel Core i5, Xeon or better
processors(s)
8+ GB RAM

1 GB for installation

1 GB for installation
Fast 7200 RPM or SSD drives
10% of boot volume should be free for
scratch disk
OpenGL 2.0 compatible video card with 256 OpenGL 4.0 compatible video card with
MB dedicated video RAM, 1280x720
1GB dedicated video RAM, 1920x1080
resolution
resolution
Photoshop CS6, CC, CC 2014
Photoshop CC, CC 2014
Photoshop Elements 11, 12, 13
Photoshop Elements 12, 13
Photoshop Lightroom 4, 5, 6
Photoshop Lightroom 5, 6
Apple Aperture 3.6
Internet connection for activation, auto
Wacom tablet for pressure sensitive
update checking, content downloads and
input
tutorials.
Hardware display calibration tool

About Windows Video Cards
If you are using Perfect Layers from a Windows based computer, it is important that you have the latest drivers for your video card installed to get the best
performance. Check with your video card manufactures website for the latest drivers. Be sure your video card is OpenGL 2 compliant and has 256MB or more of
dedicated VRAM. Many integrated video cards on low-end laptops may not meet these requirements.

Installation
To install Perfect Layers, double click the installer icon and allow the installer to guide you. You may have downloaded the installer from the on1, Inc. website or
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it may be on a DVD if you elected for a physical shipment.

You should close any supported host applications such as Photoshop, Lightroom or Aperture as well as any standalone versions of
onOne products before installing or updating.

Mac OS X
The application is installed in the Perfect Layers folder in the Applications folder.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Layers is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into /Library/Application Support/ and ~/Library/Application Support/ folder.
Windows
The application is installed in the Perfect Layers directory in the onOne Software directory in the Program Files directory.
All plug-in files for supported host applications (such as Photoshop, Lightroom, Aperture, and Photoshop Elements) found during the installation process
will be installed automatically. You will see a summary of installed plug-ins at the end of installation.
If a previous versions of Perfect Layers is found, it will be maintained or replaced based on your preference during installation.
Support files are installed into \ProgramData\onOne Software\.

Uninstalling
To uninstall Perfect Layers, follow these instructions.
You should deactivate your product before uninstalling. This will allow you to transfer your license to another computer.

Mac OSX
1. Go to the Applications/Perfect Layers/Documentation folder.
2. Double click on the Remove Perfect Layers application.
Windows
1. Go to Control Panels.
2. Under Programs select Uninstall a program.
3. In the list that comes up select Perfect Layers and then click on the Uninstall button.

Licensing and Registration
Perfect Layers will operate as a trial version for 30 days from when it is installed. If you have purchased Perfect Layers, you will want to license it so you can
continue to use it past the trial period. When you install Perfect Layers it will prompt you to license it. Simply click on the license button and enter your license
code. Your license code can be found in your order confirmation email if you purchased the download version directly from on1, Inc. If you purchased a physical
copy of Perfect Layers, a sticker on the information card will have the license code on it. Your license code allows you to install Perfect Layers on two
computers. When you enter your license code, Perfect Layers communicates with the on1, Inc. activation server and will activate your software. Your software
must be licensed and activated to function past the trial period. If the computer you are activating does not have access to the internet, you can manually
activate your software by following the manual activation instructions in the license dialog.
If you wish to move your copy of Perfect Layers from one activated computer to new computer you will need to deactivate it first. Deactivation is a simple
process. Simply open Perfect Layers and select Deactivate from the Help menu. This will deactivate Perfect Layers on the current machine, allowing you to
install and activate it on another machine.
If you lose your activation code, have your computer stolen and can not deactivate it, need to install on more than two computers or have other activation
issues please contact on1, Inc. customer by visiting the support section of the on1, Inc. website.

Product Improvement Program
We believe that the best products are made by listening to our customers. We use many methods to gather your ideas and feedback including: emails, surveys,
direct conversations, market analysis and the Product Improvement Program. The Product Improvement Program is built into our software and gathers
information about how our software is used. It is the most accurate way for us learn what features are important to you and how our products fit into your
workflow.
Enrollment in the program is voluntary. When you participate, we collect basic information about how you use our programs and basic information about your
computer. This information helps us learn what features are important to you and how we can make our software easier to use. No personal information is
collected and you will not be contacted.
You can choose to participate in the Product Improvement Program the first time you launch an on1, Inc. product. You can change your participation later, just
click the Help menu, then Help Improve on1, Inc. Products.
You can learn more about the Product Improvement Program here.

Perfect Layers

Introduction 5

Opening Files

Supported File Types

Perfect Layers uses the Photoshop (PSD) file format as its default file type. The Photoshop file format is a commonly supported, publicly documented file format
that is also the standard file for Adobe Photoshop. It is also supported by Photoshop Elements, Lightroom, Aperture and many other image editing applications.
It supports multilayered images and layer masks making it the perfect format for durable, adjustable imaging. Perfect Layers also supports the opening and
saving of the following file types, in RGB either 8 or 16-bits per pixel.
Photoshop (PSD)
Photoshop Large Document (PSB)
Tagged Image File Format TIFF (TIF)
Joint Photographic Experts Group JPEG (JPG)
Portable Network Graphic (PNG)
Camera Raw files from over 200 digital cameras
Photoshop PSD files will maintain all the layers and layer masks you create in Perfect Layers and are recommended as your main file format. Photoshop files may
also be saved as a Smart Photo , which is an onOne specific variant of the Photoshop format that allows you to re-edit your settings at a later date. If your
saved file will be larger than 2 GB or 30,000 pixels on a side, your image will automatically be saved in the .PSB or Large Document format. This is a newer
version of the PSD file format and still maintains all your layers and masks.
You can use the Edit a Copy or Save As command to save flattened TIF and JPG files or PNG files with transparency. Camera raw files can only be opened, not
saved directly. They must be saved as another file type.

Opening Files
You may open an existing file in several ways depending on which product you are using.

Perfect Photo Suite
Perfect Browse
Perfect Layers
Premium Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize
Perfect Effects Free
Basic Editions of:
Perfect B&W
Perfect Effects
Perfect Enhance
Perfect Portrait
Perfect Resize

Open
Command in
the File Menu

Open via
Perfect
Browse

Drop on the
Application
Icon

Plug-in from
Adobe
Photoshop

Plug-in from
Adobe
Lightroom

Plug-in from
Apple
Aperture

Yes
Yes
Yes
Yes

Yes
Yes

Yes
Yes
Yes
Yes

Yes

Yes

Yes

Yes

Yes
Yes

Yes
Yes

Yes
Yes

Yes

Yes

Yes

Yes
Yes

When opening an existing PSD file that has been editing in Photoshop it may contain unsupported layer types such as text layers, adjustment
layers, etc. you will see a warning. You can still open a flattened version of the image if this happens. You can learn more here.

Opening Options
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When you open a file(s) you will be presented with the dialog to the
right. It allows you to choose to work on the original file, a copy, or to
stack the files together as layers.
Edit a Copy: A copy of the original file is made using the Copy
Options below and saved in the same folder as the original.
Edit Original: The original file is edited directly. This overwrites
the original file with your changes. This option is disabled for
Raw or read-only files.
Add as a Layer: The original file is added as a layer(s) into the
current image in Perfect Layers. If no image is opened, a copy
of the first image in your selection is created.
If you select to open a copy, you can control the file type, color
space, bit-depth and resolution. If you have multiple files selected,
they will all be handled the same way.
Checking the "Don't ask me again" box will bypass this dialogue box in
the future and use the current options selected the next time you
open an image.

Smart Photos
Smart Photos are a special PSD format that allows you to save your settings and masks from each module that you use so you can go back and re-edit them
later. Any settings you make, including masks and control points, are readjustable later.

Creating a Smart Photo
To create a Smart Photo, select the Smart Photo checkbox in the Edit What dialog when you open an image. If you access Perfect Layers as a plug-in from
Lightroom or Aperture you have the choice each time you send a Photoshop file. You can also convert a layer in Perfect Layers to a Smart Layer, which
converts the image to a Smart Photo, if you have Perfect Layers.

Re-Editing a Smart Photo
There are several ways to open and re-edit a Smart Photo depending on your product configuration:

If you have the Perfect Photo Suite you can re-edit a Smart Photo by double-clicking on the module entry in the Smart Photo
History pane in Perfect Browse or the Layers pane in Perfect Layers or just click on the module in the module selector.
If you have a standalone application like Perfect Effects, Perfect B&W, Perfect Portrait or Perfect Enhance, simply open the
image and your settings will be reloaded automatically.

Similar to Smart Objects in Photoshop, Smart Photos have certain limitations. You cannot use any tool that will change the original pixels, such as
crop or transform. This includes the retouching tools in Perfect Layers, however you can use them in Portrait and Enhance. You cannot change the
image size or proportions either, so no crop or Resize.

Module Selector
The Module Selector is a feature of the full Perfect Photo Suite only.

The Perfect Photos Suite is a complete photo editor. It uses a modular approach, allowing each module to focus on one task. This makes accomplishing the task
easier by removing unnecessary tools and giving access to just what you need to get the task done. When used as a standalone application, Perfect Browse is
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the default module upon first launch, it is used to navigate your drives and cloud services to find images to begin working. In the Preferences you may change
the default startup module to Perfect Layers. If you prefer a layered workflow you can use the Layers module as the heart of your workflow, similar to using
Adobe Photoshop. Depending on how you access the Perfect Photo Suite you may never notice Browse or Layers.

The Module Selector
If you access the Perfect Photo Suite as a standalone application you
will start in Browse or Layers module.
When you are ready to edit an image you will select the module you
wish to use from the Module Selector in the upper right corner of the
main window. You can easily switch between modules by clicking on
another in the Module Selector. This allows you to perform multiple
tasks during the same editing session.

This is the module selector from the Perfect Photo Suite. It contains all of the
available modules that onOne Software makes. If you have purchased a single
product, you will only see that product module and Perfect Layers in your module
selector.

If you access the Perfect Photo Suite as a Photoshop Plug-in you see the Module Selector, but it will be disabled, you can only use one module at a time through
Photoshop. The Module Selector will also be disabled if you use the following modules through Lightroom or Aperture:
Perfect Portrait
Perfect Effects
Perfect B&W
Perfect Enhance
Perfect Resize
When you access these modules, you use them on their own and then return back to Lightroom or Aperture directly. Your file will be saved and closed
automatically.

If you want to have access to all your modules during an editing session from Lightroom or Aperture, select the Perfect Photo Suite or Perfect Layers
plug-in. This will start you in Perfect Layers and the Module Selector will be visible, allowing you to access all of the installed modules.

Using as Standalone
Perfect Layers can be used as a standalone application without the need of Photoshop, Lightroom or other host application. To launch it follow these steps:

Mac OS X
1.
2.
3.
4.

Open your Hard Drive.
Navigate to the Applications folder.
Navigate to the Perfect Layers folder.
Double click on the Perfect Layers application icon.

You can add Perfect Layers to your dock for easy access by clicking and holding the icon in the dock, then select the Keep In Dock option. If you use Launchpad
it can be found there as well.

Windows 7
1. Go to your Start Menu.
2. Select the onOne Software group.
3. Select Perfect Layers.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Layers from there.

Windows 8
1. Open the Start screen by pressing the Window key.
2. Select Perfect Layers.
If you selected the "Add Icon to Desktop" option during installation you can also access Perfect Layers from there.

Using with Adobe® Photoshop®
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If you have the Premium Edition of Perfect Layers, you can access it as a plug-in through Adobe® Photoshop® or Photoshop® Elements®. This
includes the onOne panel for Photoshop for fast access to plug-ins and their presets. As a Photoshop plug-in you can use modules in the
Photoshop workflow. This includes using selections and masks as well as Smart Objects and Smart Filters. You can also record actions for
automating and batch processing.
If you do not have the Premium Edition of Perfect Layers and would like to use it inside of Photoshop, contact onOne Customer Service about
upgrading to the Premium Edition.

To use Perfect Layers inside of Adobe Photoshop
follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Layers works on a copy
of your selected layer, not the entire
image.
3. From the File menu, select Automate,
and then the module you would like to
use.

To use Perfect Layers inside of Adobe Photoshop
Elements, follow these steps:
1. Open the image you want to work on.
2. Select the layer you want to work on.
Generally Perfect Layers works on a copy
of your selected layer, not the entire
image.
3. From the File menu, select Automation
Tools, and then the module you would
like to use.

Perfect Layers and Browse are not accessible from Adobe Photoshop or Photoshop Elements.

onOne Panel

Users of Adobe Photoshop can also access Perfect Layers as plug-ins using the onOne Extension Panel.
This provides fast access to the Perfect Layers and its presets. To access the onOne panel, go the
Window > Extensions menu in Photoshop and select onOne.
The onOne panel behaves just like any other panel in Photoshop. It can be minimized or nested with
other panels. To access a module, simple double-click on it. To use a preset, single click on the module
name. A menu of available presets will be displayed. Simply double-click on one to apply it to your
selected layer.

If you wish to record actions using Perfect Layers be sure to access it from the File >
Automate menu when recording.

Using with Adobe® Lightroom®
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If you have the Premium Edition of Perfect Layers you can access Perfect Layers as a plug-in inside of Lightroom. This provides an integrated,
round-trip workflow.
Perfect Layers is the perfect companion for Adobe Photoshop Lightroom. It integrates tightly with it and provides a seamless experience for
enhancing your images. There are several ways to use Perfect Layers with Lightroom.

Plug-In Extras
Perfect Layers can be accessed from the File > Plug-in Extras menu.
This is the preferred way to access it. It gives you access to all installed
modules and has the most flexibility in how the files are handled. To edit
an image in Perfect Layers follow these steps.
1. Select the image in Lightroom.
2. Go the File menu and select the Plug-In Extras flyout.
3. Select the module you would like to use.
When you access Perfect Layers as a plug-in from Lightroom the module
selector is only available for Perfect Layers or Perfect Mask. When you
select one of these modules you can use as many modules as you
desire during the same editing session. At the end of the editing session
you must save and close the image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask
your image will be sent to it directly and when you press Apply, the
image is saved and closed automatically and you are returned back to
Lightroom.
Selecting Multiple Images
If you have multiple images selected, the behavior varies depending on
which modules you select.
Perfect Layers or Perfect Mask: Each file will be opened in its
own tab. Then you may access any modules available in the
Module Selector.
All other plug-ins: Each image is opened in turn and you may
adjust the settings on an image by image basis.

Lightroom Plug-in Preferences
When you use Perfect Layers through the Plug-In Extras menu there
are important file handling options that are controlled in the
Preferences dialog of the Perfect Layers module. These need to be
configured in advance based on your desired workflow.
File Type: The file type drop-down menu determines what
type of file will be created. The default is PSD, which
maintains layers. You can also select JPG or TIF if you prefer
those formats and are not concerned about maintaining
layers. The last option is same as source, which maintains the
file type of the original file, except for Camera raw files which
are saved as PSD.
Color Space: The color space drop-down menu determines
what RGB working color space is used; Adobe RGB 1998,
sRGB or ProPhotoRGB.
Bit Depth: The bit-depth drop-down menu determines the
bit depth, either 8-bit or 16-bit per pixel.
Resolution: The resolution drop-down menu determines the
resolution of the file.
Stack with Original: When enabled, the new image is
stacked with the original image, making it easier to organize.
Use Original for Single PSDs: When enabled, if you select
a single PSD file, it will be edited directly, rather than having
a copy made.

External Editor

You can also access modules as external editors for all modules except
Perfect Layers or Perfect Mask. You can access them from the Edit In...
contextual menu. These behave similarly to the plug-ins in the Plug-In
Extras menu but ignore the preferences set in Perfect Layers. Instead
you have the option to control a subset of these options each time you
access a module, in the same way you do when you access Photoshop
or any other external editor.
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Batch Processing
There are two ways to batch process multiple images in Lightroom with Perfect Layers.

Perfect Batch
Perfect Batch is the preferred way to batch process. You start with a
selection of images in Lightroom or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the File > Plug-In Extras
menu in Lightroom. You can learn more about using in the Perfect Batch
section of this user guide.
Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

Lightroom Export
You can also batch process with a single module through the Export
menu in Lightroom. This is useful if you need to remove metadata or are
more comfortable with Lightroom's Export. Batch processing through
Export is driven by presets, so you need to create a preset that
accomplishes the work you desire first.
1. Select the images you wish to batch process.
2. Go the Export under the File menu.
3. At the top under the Export to drop-down, select the module to
use.
4. Complete the module specific options below. These will start
with the preset, followed by options for selecting the export
location, file naming, file size, etc.
5. Press the export button.

You cannot save Lightroom export presets or use
the Export with Previous option.

Using with Apple® Aperture®
If you have the Premium Edition of Perfect Layers you can access Perfect Layers as a plug-in inside of Aperture. This provides an integrated,
round-trip workflow.
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Perfect Layers integrates tightly with Apple Aperture and provides a seamless experience for enhancing your images.
Perfect Layers can be accessed from the Photo > Edit with Plug-In menu. To edit an image in Perfect Layers follow these steps.
1. Select the image in Aperture.
2. Go the Photo menu and select the Edit with Plug-In flyout.
3. Select the module you would like to use.
When you access Perfect Layers as a plug-in from Aperture the module selector is only available for Perfect Layers or Perfect Mask. When you select one
of these modules you can use as many modules as you desire during the same editing session. At the end of the editing session you must save and close
the image from the Perfect Layers module.
When you select a module other than Perfect Layers or Perfect Mask your image will be sent to it directly and when you press Apply, the image is saved
and closed automatically and you are returned back to Aperture.

Selecting Multiple Images

If you have multiple images selected, the behavior varies depending on which modules you select.
Perfect Layers or Perfect Mask: Multiple images will be opened in separate tabs.
All other plug-ins: Each image will open in a series so you can adjust the settings on each image.

The file type, bit-depth and color space of the image is determined by the preferences in Aperture for external editors. Perfect Layers will maintain
the file type, either PSD or TIF automatically to support compatibility with plug-ins from other manufactures. Keep in mind only PSD files store reeditable layers and mask.

Batch Processing
Perfect Batch is the preferred way to batch process. You start with a
selection of images in Aperture or folder on disk, then batch-process
them with multiple modules at the same time to solve complex
workflows. For example a portait photographer can prepare images for
a sales session by retouching every face, adding their stylized look and
output small JPGs with their logo watermark, all in the same batch
process. You can access Perfect Batch from the Photo > Edit with Plugin menu in Lightroom. You can learn more about using in the Perfect
Batch section of this user guide.
Key batch processing features include:

Start with a selection of images from Lightroom or
any folder you select.
Batch process with a single module for simple jobs or
create workflows where you string multiple modules
together.
Save workflows to use over and over.
Pause on the first image to confirm your set-up, then
automatically process the rest to match.
Add a visual watermark, like your logo, to every
image.
Edit files in place or create new files with different
size, name or file type.

Using with Other Applications
You can use Perfect Layers as an external editor with many other workflow applications such as Adobe Bridge or Apple iPhoto. First check the application user
guide to see if it supports external editors. It should detail how to configure the host application to use an external editor. Generally this will include selecting
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Perfect Layers setting the file type to send to it. It is best to use PSD files if supported. Below are the instructions for configuring iPhoto.

1. Open the Preferences dialog, from the iPhoto menu.
2. Click on the Advanced tab.
3. From the Edit Photos: pop-up select the In Application... option
(note if you have ever selected another external editor, it may
be listed here instead.)
4. From the Choose dialog that appears, navigate the the Perfect
Layers folder, inside the Applications folder and select [Product
Name].
5. In the RAW Photos: option, uncheck the Use RAW when using
external editor option, and check the Save edits as 16-bit TIFF
files option .

Printing
You can print your photos to your printer using the Print function.
1. Select Print from the File menu.
2. Select your printer from the Printer pop-up.
3. Press the Print Setup button to adjust printer specific options
such as paper size and type and printer specific color
management options.
4. Adjust the number of copies, orientation and output
resolution.
5. In the Print Area section set the area you would like to fill with
image. The preview on the left shows the paper size and
margins as well as the print area and how the image will fit or
fill the print area.
6. Select the output Printer Profile and Rendering Intent to
properly adjust the photos colors to your printer and paper
combination. You may also select the Printer Managed Color
option to let your printer driver manage the color instead.

Tip: If you have already cropped and sized your image to your desired print area size, simply set the width and height to match in the Print Area
section.

Managing Extras
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What are Extras?
The Extras Manager let's you import and manage
your own Extras content. Extras are:
Backgrounds that can be imported and
used in Perfect Layers.
Borders than can be imported and used in
Perfect Layers, Perfect Effects and
Perfect B&W.
Textures that can be imported and used
in Perfect Layers and Perfect Effects.
Presets for Perfect B&W, Perfect Effects,
Perfect Enhance, Perfect Portrait and
Perfect Resize.
Extras can be content that you download from
the onOne website or content that you create on
your own.
The Extras manager lets you create categories
for each Extra type, import files as extras and
delete user-added extras you no longer want.
You can access the Extras Manager from the File
menu in Browse and Perfect Layers or the Preset
menu in modules that use presets.

How to Import Extras
Importing extras is simple. Start by opening the Extras Manager then follow these steps.
1. Select the type of extras you wish to import in the left column (Backgrounds, Borders, etc.) You can only import extras of one type at a time.
2. Click on the Import button in the footer of the left column. A Finder or Explorer Window will appear where you can select the files to import. If you
want to import an entire folder, click into the folder then select the first file, then shift-click on the last file. Click import when you selection is
complete
3. Select a category for your extras to live in. This is where you will be able to find it inside of the Perfect Layers. You can select from an existing
category or create a new one.
When your extras have been imported you will see them in the Extras Manager in the category you selected, in the type of extra they belong to.

What Type of Images Can I Import as Extras?

Backgrounds and Textures may be any image file that Perfect Layers can open including jpg, tif, raw or psd files. Border files
must have a large central area that is transparent. This means that only files that support transparency like png can be imported
as borders.
If you have a .ONPreset file that you have downloaded from the onOne Software website, simply double-click on it to install it. There is no need to
import it through the Extras Manager.
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Browsing Extras
You can browse and open Extras from the Browse
module. In the Sources pane there are sources
for onOne Extras (extras that are provided by
onOne when you installed Perfect Layers) and
User Extras where you can browse and open
extras you have installed.
Inside each source folder are folders for the
Backgrounds, Borders and Textures. You can
open these as layers into Perfect Layers to add
them to an image or layout you are working on.

Using Extras in Perfect Layers
Browsing extras in Perfect Layers is similar to the
Browse module. Click on the Extras tab of the left
column mini-browser. You will see top-level folders
for onOne Extras and User Extras. Inside of
these will be sub-folders for Backgrounds,
Borders and Textures. You can double-click on an
extra to add it to your current image, just use the
"Add as a Layer" option when asked how you
want to open the file.

Then you can use the transform
tool to size and position the extra
on your image.
Use the Layers pane to change the
order, opacity and blending mode.
Use the Masking Brush and
Masking Bug to selectively apply
the extra.
Use the Perfect Eraser to remove
distractions from the extra if
needed.
If you save your file as a layered PSD file, you
can always re-open the file again and have
access to all of the layers and masks for further
editing.
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How to use in a Module
You can access certain extras, like borders and
textures, inside of modules like Perfect Effects
and Perfect B&W. To use them follow these
steps:
1. Open an image into Perfect Effects.
2. In the Filter Options pane, select the
correct filter type, either Borders or
Texturizer.
3. From the Category pop-up, select a
category you have imported. User added
extras categories appear at the bottom
of the category list.
4. From the Texture pop-up select a texture
from the category you selected.

How to Delete Extras
You can remove imported extras using the Extras Manager. Follow these steps:
1.
2.
3.
4.

Open the Extras Manager.
Click on the extras type that contains the content you wish to remove. This will display categories within that extras type.
To delete an entire category, select in the left column and click on Delete button in the footer of the left column.
To delete individual extras, select them in the right column and click on the Delete button in the footer of the right column.
Deleting extras is permanent and can not be undone!

Preferences
Note: This page refers to the Preferences dialog for the Perfect Photo Suite. If you have an individual product not all of the options detailed below may
be available.

The preferences dialog contains general application settings. The preferences are accessed from the Perfect Layers menu on Mac or the Edit menu on
Windows.

Perfect Layers
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The preferences contain the following controls:

General Settings
1. Working Color Space: When a new file is created or
file is opened and has no color profile associated with it,
this is the assumed color profile for the image. Images
that come from plug-ins or have tagged or embedded
profiles will use the associated profile instead.
2. Scrolling Controls: Lets you select how the mouse
scroll wheel or scrolling gesture works. The options are:
1. None: Default
2. Preview Zoom: Adjusts the zoom of the
preview window. Scrolling up increases the
zoom, scrolling down decreases the zoom. It is
important that the zooming is comfortable, not
too fast or slow or jerky.
3. Preview Pan: Pans the image, like using the
pan tool or navigator. It is important that the
panning is comfortable, not too fast or slow or
jerky.
4. Brush Size: Adjusts the size of the current tool
if relevant, such as a brush tool.
3. Preview Background Color: You may select the color
of the background behind the preview image. The default
color is black. There should be options for black, white,
light gray, dark gray and custom... The custom option a
color picker where you can select your own background
color
4. Start In: Determines which module will open

at launch. Browse is the default.
5. Check of Updates on Launch: Enabled by default,
the product will communicate with onOne server at
launch and if an update is available it will prompt you to
download, or skip.
6. Warn when leaving files in Layers: Enabled by
default, if you have unsaved files open in Layers and
want to close the program a warning dialog will appear
with the options to Save & Close, Cancel, or OK which will
close without saving.
7. Language: Select which language the app user

interface is presented in. Usually this is
determined automatically but the locale of the
operating system but can be manually set.

Plug-ins

1. Smart Photos Save PSD Files As: When you send a
PSD to Perfect Layers via a plug-in from Lightroom or
Aperture you can choose between saving the file as a
normal photo or a Smart Photo.
2. File Type: Specifies four options. PSD (Supports Layers,
Defaults Setting. Same as Source (PSD for Raw). TIFF
(No Layers). JPEG (No Layers).
3. Color Space: Specifies the color space to use when
processing copies from Lightroom. This is similar to the
working color space pop-up in the general preferences
tab, however there are only the three options supported
by Lightroom: sRGB, Adobe RGB 1998 and ProPhotoRGB.
4. Bit Depth: Sets the bit depth for the copies created by
Lightroom, the options are 8 and 16-bit.
5. Resolution: Sets the resolution of copies created by
Lightroom.
6. Stack with Original: Enabled by default, copies
created by Lightroom are stacked with their original or
source image.
7. Use Original for Single PSDs: Enabled by default. If
your selection is a single PSD file, the original PSD is
opened rather than creating a copy.
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Introduction 17

Performance Settings

1. Memory Usage: Specifies the amount of system
memory (RAM) that is used by the application. The
default is 80%.
2. VRAM Usage: Specifies the amount of video memory
(VRAM) that is used by the application. The default 80%.
3. Process 8-bit images as 16-bit: When enabled, 8-bit
images are handled in a 16-bit space to reduce
processing artifacts. This is recommended unless you
have a computer with low memory.
4. Scratch Folder Location: Allows you to move or reset
your memory cache. This is helpful if you have a small
SSD drive as your system drive. This information is
purged after each time you quit the application.
5. Browse Cache: Stores thumbnails previews on disk so
that the next time you browse a folder it loads much
faster. Here you can adjust the memory cache size or
amount of information stored, empty, move, and or
reset.

Services

1. Services in Sources: Control which online storage
services are displayed in the Sources pane in Perfect
Browse.

Perfect Layers
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Perfect Layers

Perfect Layers provides the benefits of a layered workflow without the need for Adobe Photoshop. It can also act as the hub of
your workflow in Perfect Layers if you are familiar with the Photoshop and Plug-in workflow. It can be used for:
The opening and saving of files.
Merging multiple files into a single layered file.
Combining the best parts of several images together using layers and masks.
Selecting the layer you would like to work on in other modules.
If you access the suite via Adobe Photoshop you won't see Perfect Layers.
On its own, Perfect Layers is incredibly useful, especially if you don't own Adobe Photoshop. It is the fast and easy way to a
layered workflow. Use it to change skies, composite multiple images together or retouch portraits.
Some of the features:
Combine multiple images into a layered Photoshop-compatible file.
Adjust layer size, position, blending mode and opacity.
Use the built-in layer masks and masking tools to blend multiple layers together.
Use the Retouch Brush to remove blemishes and dust spots.
With Perfect Layers, multiple images can be merged as separate layer of a single new file. Then you can easily reorder and
position each layer; As well as change blending modes and opacity. In addition, you can selectively blend, or mask layers
together using the Masking Brush and Masking Bug. Perfect Layers saves its work as native layered Photoshop files so users can
open them directly with Photoshop for additional editing.

Getting Started
This getting started section will give you the basics of using Perfect Layers. If you have never used Perfect Layers before, this
is a good place to start. You might also try watching the getting started video link. For detailed information on steps and
controls mentioned in the getting started section, see the "Using Perfect Layers" section instead.

Pages in this Section
Perfect Layers Workspace
Perfect Layers Tool Well
Navigating the Preview
Navigator, Loupe, Histogram and Info
Preview Window Modes
Using the File Browser

Perfect Layers Workspace
Perfect Layers provides you with an easy-to-use work space for editing your photos. Below is an overview of the main sections.

The Main Window:
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The main window sections of Perfect Layers:
A. Browser Section: This is located on the left side of the window. It is where you browse and select your images.
B. Tool Well: This is where the tools are located.
C. Preview Window: This is the main section where you preview and work on images.
D. Tool Options Bar: This strip above the preview window contains the options for the selected tool.
E. Navigator, Loupe Histogram and Info Pane: This pane will access navigational, loupe, histogram features as well as file information.
F. Layers Pane: This is where you control the layer order and apply blending modes.
G. Module Selector: This is where you select other modules to work in.
H. Close & Save Buttons: This is one way to save or close the current image.

Perfect Layers Tool Well
There are fifteen different tools in the tool well.
More details about each tool are covered in the following chapters, click on a tool title to learn how to use it.
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Transform Tool

This moves and changes the size and rotation of your layer.

Crop Tool

This crops your image.

Trim Tool

This trims a single layer.

Perfect Eraser

This uses content aware technology to remove unwanted objects.

Retouch Brush

This retouches small imperfections.

Clone Stamp

This tool paints over an area from a sample of another area.

Red Eye Tool

This tool reduces red eye.

Masking Brush

This masks areas using brush strokes to expose underlying layers.

Quick Mask Tool

This tool masks out large similar areas quickly.

Masking Bug

This masks areas using gradients to expose underlying layers.

Line Mask Tool

This tool is for creating linear masks.

Refine Brush

This tool refines the mask intersections to cleanly mask difficult areas like hair.

Chisel Mask Tool

This tool moves the edge of the mask slightly to remove fringes.

Blur Mask Tool

This tool softens the mask slightly to blend more naturally.

Pan Tool

This tool repositions your image within the preview window.

Zoom Tool

This tool changes the magnification in the preview window.

Navigating the Preview
Perfect Layers provides several ways to navigate and view your image in the Preview window.
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The Preview Window above is the main section where you preview and work on images.

Hand Tool

The Hand tool is used to position the image within the Preview window, whenever the preview zoom is larger than the viewable area.
To pan (scroll) in the Preview window:
Select the Hand Tool and drag the image until you locate the area you wish to view.
With any other tool selected, hold down the spacebar while you drag the image in the window.

Double-click the Hand tool in the Toolbar to set the image to a magnification that fits completely in the current window size.

Zoom Tool

The Zoom tool changes the magnification of the image in the Preview window.
With the Zoom tool selected:
Click in the Preview window to zoom in and center the image at the location clicked.
Click and drag in the Preview window to draw a rectangular, the screen fills with the area within the rectangle when you release the mouse.
Hold the Option key (Mac) or Alt key (Win) and click to zoom out.

Double-click the Zoom tool in the Toolbar to set the image to 1:1 or 100% magnification, showing every pixel. This is best when examining small details.

Navigator, Loupe, Histogram and Info
At the top of the control panel on the right of the main window is the Navigator | Loupe | Histogram | Info panes. It contains four useful tools for
inspecting and viewing details of your image.

The Navigator Pane
This gives you a birds-eye view of your image. The blue square region marks the image area
that is visible in the preview pane. You can pan your image by clicking and dragging inside the
blue region.
At the bottom of the Navigator pane are several Zoom presets. Click on a Zoom preset to
activate.
FIT: Zooms to fit the current canvas size. This allows you to see your entire image.
100: Zooms to 100% or actual pixels. This is best for judging small details.
50: Zooms to 50%
25: Zooms to 25%
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The Loupe Pane
This gives you a magnified view of the section of the preview under the cursor. This allows you
to view the quality of your results while maintaining a complete view of your image.
At the bottom of the Loupe Pane is a sliding for adjusting the zoom level.

The Histogram Pane
This gives you a color chart of the shadow, mid-tone and highlight areas based on the image
RGB values. This is useful to show areas within the image that may be clipping. Clipping is when
your image contains pure blacks or white and can signify loss of highlight or shadow detail.
The left side of the histogram represents the shadows, while the right represents the highlights.
At the top of each end is a triangle. If the triangle is lit, there is clipping on that side of the
histogram. If you click on the arrows, you will activate the clipping overlay on your image. The
areas of your image with a blue overlay are pure black, while the areas with the red overlay are
pure white. You can turn the clipping view off again by clicking on one of the triangles. You can
also temporarily enable clipping view by holding down the J key at any time. The clipping view is
useful when you are making adjusts to the brightness and contrast of your image.
The Histogram pane also displays the RGB values under the cursor at the bottom of the pane.

The Info Pane
The info pane will display important metadata about your file including:
Camera type
File type
Focal length and lens information
Date and time captured
Exposure information
ISO
Shutter Speed
Aperture
Exposure Value
Filename
Color Space
Dimensions
File Size and Bit Depth
If your camera allows for GPS the GPS button will be viewable and you can click on it to get the
GPS cordinates for where the image was taken. This feature only works if you have GPS enabled
on your camera or mobile device. Otherwise you will not see the GPS button.
The Info panel is not visible when you access a Module as a Photoshop plug-in.

Preview Window Modes
The preview window has several modes including; single image, side-by-side (horizontal or vertical) and split-screen (horizontal or vertical) versions of an
image. This allows you to compare layers side-by-side or to view a layer mask and the layer side-by-side. At the bottom left of the Preview Window is a
button that toggles and shows the current Preview Mode. You can also change the mode from the View menu.
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Single Mode Screen.

Left-Right Screen.

Top-Bottom Screen.

Top-Bottom Split Screen.

Left-Right Split Screen.

Tip: You can use the keyboard shortcuts below to quickly switch view modes. Items in parenthesis are for Windows.
Command (Control) L:
Command-Option (Control-Alt) L:
Command (Control) T:
Command-Option (Control-Alt) T:
Command (Control) Y:

Change the preview mode to Left/Right.
Change the preview mode to Left/Right Split screen.
Change the preview mode to Top/Bottom.
Change the preview mode to Top/Bottom Split screen.
Change the view mode to single image.

Using the File Browser
Built into Perfect Layers is a file browser, located in the left panel. You can use it to browse your images as well as content you download from the onOne
website. Below is a description of the controls in the file browser.
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A. Browser Tabs: This switches between the File tab and the Extras tab. The Extras tab
displays the included backgrounds, borders and textures.
B. Folder Tree: This drop-down menu displays the folder paths above the folder you are
browsing. You can use this to quickly navigate up the folder tree. The currently selected root
folder is displayed here as well.
C. Search Field: Use the search field to locate files in the current sub-folder.
D. Image Thumbnails: Images are displayed as thumbnails and will have the filename and
extension listed below it.
E. Resize Handle: On the right edge is a resize handle that you can drag to change the size of
the browser or close it.
F. File Info: This window will show captured and modified dates, color space, exposure settings
and size on disk if applicable.
G. Browser Modes: These icons control the browser views. One column, two column, three
column or list view.
H. Quick View Browser Button: Press this button to open the current folder in the Quick
View Browser.

Browsing a Folder
You can select which folder to browse by selecting a folder in the drop down menu under Files.
The last folder you browsed will be remembered and displayed automatically.

Navigating the Browser
To open a sub-folder, click on it. To close it, click on it again.
Only one top-level folder can be open at a time.
Double-clicking on a folder sets it to the root folder and its name will appear in the folder tree drop-down.
The selected item, either a folder or file, will have a light silver box around it.
You can use the up and down arrow keys to change your selection in the browser.
You can open or close folders using the command (control on Windows) up and down arrows.
You can select multiple files by holding down the shift key.

You cannot move or delete files from the File Browser.

Opening Files from the Browser
You can open an image in the browser by double-clicking it. If you already have an image open you will be prompted to either merge the selected file as
anew layer or to open it as a new file.
If you have multiple images selected, you can open them as layers using the Open Selected from Browser command in the File menu.
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Searching for Files
To search for files in the currently selected folder, type in the name of the file in the search field.
The search results appear in a new sub-folder called search results, which will be selected automatically.
You can clear the search field by pressing the x at the right end of the search field.

Browser Pop-Up
To view a larger preview on an image, enable the Show Browser Pop-up in the View menu.
When you mouse over a thumbnail, a larger preview will be displayed in a pop-up window.

Resizing and Closing the Browser
The browser can be resized by dragging the resize handle on the right margin of the browser.
The browser can be closed or reopened by clicking on the resize handle or using the cmd (control on Windows) left and right arrow keys.

Browser Modes

The browser offers four viewing modes. Three that display
thumbnails in columns and one list view. The browser
modes are selected using the browser mode icons at the
bottom of the browser.

single column view

two column view

list view

Extras Tab
The Extras tab displays add-on content including backgrounds, borders and textures.
When you download content packs from the onOne website they are automatically installed in the Extras tab.

Quick View Browser

The Quick View Browser adds an elegant full-screen view of your images, filters and
presets. Whether you are looking for the right image or the right look, the Quick View
Browser will make fast work of the problem. Just press the Quick View Browser button (or
the option (alt) right arrow keyboard shortcut and you will see the full array of options to
choose from. You can visually navigate categories, then dive into them to find just the right
look.
Browse folders and images quickly to find the right one to work on.
View all your filter or preset categories at one time, then dive into them to find the
perfect look with an effortless, tablet feel.
Variable thumbnail sizes gives you a few large previews or many small ones
depending on your screen size and content.
Back button and breadcrumbs make it easy to navigate a complex folder structure.
Use your keyboard arrow keys to navigate.
Press the return key to select an item or open a folder.
Use the command or control left arrow to go up a folder level.
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Using Perfect Layers
This section covers the complete use of Perfect Layers. It includes how to use each tool and control as well as information on
preferences and menu options.

Pages in this Section
Creating a New File and Adding Layers
Adjusting Canvas Size
Working with Layers
Menus
Keyboard Shortcuts

Creating a New File and Adding Layers
You can create a new file in several ways.

1. Create a new, empty file from the File > New menu. The New
Image dialog is presented, see the image to the right. From the
New Image dialog, you have the following options.
Name: Presets the name of the image.
Preset: Lists a range of preset image dimensions for
common print sizes.
Width: Sets the width. There is a drop-down menu that
includes inches, cm and pixels.
Height: The same as the width, just for setting the
height.
Swap Dimensions button: Pressing this button will
swap the current width and height.
Resolution: Sets the resolution of the image.
Color Space: Sets the color space (icc profile) of the
image. The default is set based on the user
preferences. Only RGB color space profiles are
available.
Bit Depth: Sets the bit depth of the image, either 8-bit
or 16-bit.
1. Merge one or more images together using the Add Layer from
File command.
2. Merge one or more images together using the Lightroom or
Aperture plug-ins or external editor option.
3. Dragging one or more images onto the Perfect Layers icon.

Adding Layers from Files
You may add images (flat or layered) as layers into an open file by:
1. Using the Add Layer from File command from the File menu.
2. Opening a file from the Browser or the Browse module and
choosing the Add as a layer option.

Working with Tabs
Each photo you open in Perfect Layers is contained in its own tab. The
tabs for each photo appears at the top of the interface. Close a tab by
clicking on the "X" icon.
How do I combine two tabs in to one?
In Tab 1 choose Layer > Copy Layer. Click to switch to Tab 2 and
choose Layer > Paste Layer.
Close a by clicking "X".

Adjusting Canvas Size
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The canvas size, or image size is the aperture through which you
view the layers. An image may have layers that are larger than the
canvas size and are partially hidden by the canvas size aperture.
1. When creating a new empty file from the File > New dialog, an arbitrary
size is set by you. When creating a new image, you have the option to set
the resolution.
2. When creating a new PSD file by merging other files together using the
Add Layer from File command, the source image that has the largest pixel
dimensions will become the bottom most layer and will set the canvas size.
The canvas size is adjustable by the user.
3. When opening an existing PSD file, the canvas size is already set. The
canvas size is adjustable by the user by accessing the Canvas Size dialog
from the Edit menu.
Layer image data outside the canvas area is maintained.

Adjusting the Canvas Size
1. In the top section, Current Size, it displays the current canvas size and is non-editable.
2. Below the Current Size is the New Size section. It displays the current width and height and is editable.
There is a drop-down menu with options for pixels, inches and cm.
There are width and height fields where you can adjust the canvas size.
The canvas size dialog does not interpolate (resize all the layers at the same time). This is the same as the image size dialog box in
Photoshop when the resize image option is disabled.
There is a lock proportions toggle that locks the width and height proportions together. Adjusting the width will change the height
proportionally. This option is on by default.
At the top of the new size section is a pop-up called Set To.
The values in the pop-up are; Current Layer, All Layers and Custom.
When a user selects the current layer option, the width, and height are set to the size of the currently selected layer(s).
If the user selects all layers, the width and height are set to the union of all the layers, making all the pixels on all layers
visible in the canvas.
If the user selects one of the layer size options and then manually overrides them, the pop-up changes to custom.

Working with Layers
The concept of a layers and a layered workflow is the key benefit of Perfect Layers. Having the ability to create composites of multiple layers is the most
powerful tool in a photographer's arsenal and is the heart of many photographers workflows. This feature is lacking in Lightroom and Aperture and requires
photographers to purchase Photoshop which is expensive and cumbersome to learn.
Articles in this Section
The Layers Pane
Transforming Layers
Crop Tool
Trimming Layers
Using Color Fill Layers
Perfect Eraser
Retouch Brush
Clone Stamp
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Clone Stamp
Red-Eye Tool
Using the Masking Tools

The Layers Pane
Layers are listed in the Layers Pane, located in the right column. It lists the layers and contains the controls to adjust them.

Layer Visibility
You may change the visibility of a layer (hide it) by pressing the eye icon to the left of the layer
thumbnail. This will hide a layer without deleting it. You can hide all layers except the current layer
by holding the option (Mac OS X) or alt (Windows) key when clicking on the eye icon. This is
especially useful for viewing the bottom most layer, which in some cases is the original image. This
acts like a before and after preview.

Changing Layer Order
You may change the order of layers by dragging and dropping layers into the order you prefer. You
may select multiple layers at the same time by holding down the command (Mac OS X) or control
(Windows) key while clicking.

Renaming Layers
You can rename a layer by double-clicking on it. The name turns into an editable field. Type in your
preferred name and press enter. When merging files together the layer name is the name of the
source image. This is a useful verification of the source image.
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Deleting a Layer

You may delete a layer by selecting the layer, then pressing the Delete button

. You may also use the Delete key on your keyboard.

Duplicating a Layer

You may duplicate or copy the current layer by pressing the Copy button
keyboard shortcut.

. You may also use the command (Mac OS X) or control (Windows) + J

Merging Layers

You may merge layers by selecting them and then pressing the Merge button
keyboard shortcut.

. You may also use the command (Mac OS X) or control (Windows) + E

Creating Color Fill Layers
Color Fill Layers are new layers filled with a solid color. They are useful for altering the color and tone of the image. To create a Color Fill Layer, press the
Fill button

. You can learn more about using Color Fill Layers here.

Convert to a Smart Layer
You can convert any layer into a Smart Layer, if the image is a Smart Photo. This allows you to re-edit any settings you add to a layer in modules like
Perfect Effects.

Changing Blending Modes
Blending modes determine how the selected layer blend with the layer(s) below it. The default blending mode is normal. This maintains the full opacity of
the upper layer. Perfect Layers also supports many other blending modes which can be used to alter the brightness, contrast and color of the image by
combining either a copy of the underlying layer or a Color Fill Layer.

Changing Opacity
The opacity slider controls how opaque, or how strong the selected layer is. The default is 100%. At lower settings, the layer will blend with the layer(s)
under it. Altering the blending mode and opacity of a layer can create a wide range of color and tone effects.

Layer Masks
If you use any of the masking tools, a layer mask will be created automatically. A layer mask appears as grayscale thumbnail next to the layer icon. There
is no need to select the layer mask to work on it, invert it, or reset it. Think of it as always selected with the layer. You can also copy and paste Layer
Masks from the Layers menu or by dragging and dropping them from layer to layer.

Transforming Layers
Transform Tool: The Transform Tool is located at the top of the tool well. It is used to manipulate the image and layers.
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A layer may be repositioned, sized or rotated using the
Transform Tool. When the Transform Tool is selected,
transform handles will appear on the edges of the selected
layer. You use these transform handles to manipulate the
image. You can only transform one layer at a time.

Repositioning a Layer
To reposition a layer, simply click and drag inside the
transform box. You can also use the keyboard arrow keys to
nudge a layer one pixel in any direction.

Resizing a Layer
To resize a layer, click and drag on any of the transform
handles. Clicking on a corner handle allows you to adjust two
sides simultaneously. Clicking on a side handle allows you to
adjust that side. If you hold the shift key down while adjusting
the size, the proportions of the layer are maintained. If you
hold down the option (Mac OS X) or alt (Windows) key while
resizing your image will resize from the center instead of from
the edge. You can hold down both the shift and option or alt
simultaneously to resize, proportionally from the center.
You can also type in the size you desire in the Tool Options
Bar (see below) in the width and height fields. You can also
size a layer to fill the canvas automatically by pressing the Fill
but in the Inspector.

The Tool Options Bar

Rotating a Layer
To rotate a layer, move the Transform Tool near but just outside a corner transform handle. Notice that the tool cursor changes to a rotate cursor. Now
click and drag to rotate the layer. You can also use the opt (alt) left and right arrow keys to rotate a layer when the transform tool is selected. To rotate
the layer quickly in 90 degree increments, you can use the rotate left and rotate right buttons in the Tool Options Bar.

Flipping a Layer
You can flip a layer either horizontally or vertically by pressing the flip buttons in the Tool Options Bar.
When you have completed your transforms you need to commit the changes. You can do this by pressing the Apply button that appears in the Tool
Options Bar or by pressing the enter key. You can cancel a transform by pressing the Cancel button in the Tool Options Bar or by pressing the escape key.

Crop Tool
Crop Tool: This is used to crop and resize the entire image. The crop tool removes any pixels outside a crop box
and changes the canvas size at the same time. To crop the image, select the Crop Tool from the tool well. Then
adjust the corner handles of the crop tool overlay. The area outside the crop box appears darkened for guidance. You
can resize and move the image inside the crop box. When you are satisfied with your settings, press the Apply button
in the Tool Options Bar or press enter.
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Moving the Image: To move the image inside the crop box,

simply click and drag inside the box. You can also nudge the
image using the arrow keys on your keyboard.
Resizing a Crop Box: To resize the Crop Box, click and drag

on any of the resize handles. Clicking on a corner handle
allows you to adjust two sides at the same time. Clicking on
a side handle allows you to adjust that side. If you hold the
shift key down while adjusting the size, the proportions of
the box are maintained. To rotate the crop box, move
outside a corner until the tool changes to rotate. You
can also set the aspect ratio or size of the crop box in the
tool options bar.

The Crop tool is not available when using a Smart Photo.

Crop Tool Options

Preset pop-up: Pop-up controls the crop tool mode as well as aspect ratio and document size presets.
Width: Sets the width of the crop box.
Swap Dimensions: Swaps the width and height. Handy for rotating the crop box.
Height: Sets the height of the crop box.
Units: Determines the unit of measure: Pixels, inches, centimeters, etc.
Leveling Tool: Click and drag this tool across an element in your image that should be level.
Angle: See and adjust the angle of rotation.
Rotate: Rotates the image 90 degrees.
Cancel: Resets the crop tool.
Apply: Applies the crop and resizes your photo.
Crop Tool Modes

The Crop Tool works in three modes:

Freeform: In this mode you can adjust the crop box
any way you like. The image will not be resized. Any
area outside the crop box will be trimmed off. Use
this mode if you just want to change the shape or
recompose your image for general use.
Aspect Ratio: You can lock the crop box to an
aspect ratio. This makes sure the crop box shape
doesn't change, just the size. Use this option to
trim existing pixels while maintaining a ratio without
resizing the image.
Document Size Presets: Document Size Presets
allow you to crop and resize your image at the same
time. If you know your intent is to print the image at a
certain size you can crop and resize the image at the
same time. Many common sizes are included plus you
can create your own.

Leveling the Image
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The Crop Tool has a special Leveling Tool for automatically adjusting
your image to be level.
1. Select the Crop Tool.
2. Select the Leveling Tool from the Crop Tool Options

Bar. Your cursor will change to the Leveling Tool.
3. Click and drag a line across your image that should be

level, either horizontally or vertically. When you
release the mouse the image will be adjusted
automatically to the correct angle.

Trimming Layers
Trim Tool: The trim tool is used to trim or crop a layer. It removes any pixels outside of a crop-style box for the current layer.

Using the Trim Tool
To trim a layer, select the Trim Tool from the tool well. It looks like a pair of scissors. Then
drag a box over the area you wish to keep on the selected layer. The area outside the trim
box appears darkened for guidance. You can resize and move the trim box. When you are
satisfied with your settings, press the Apply button in the Tool Options Bar.

Moving the Trim Box
To move the Trim Box simply click and drag inside the box. You can also nudge the box
using the arrow keys on your keyboard.

Resizing a Trim Box
To resize the Trim Box, click and drag on any of the resize handles. Clicking on a corner
handle allows you to adjust two sides simultaneously. Clicking on a side handle allows you
to adjust that side. If you hold the shift key down while adjusting the size, the proportions
of the box are maintained. You cannot rotate a Trim Box. You can manually enter the size
of the trim box in pixels using the width and height fields in the Tool Options Bar (see
below).
When you have completed your adjustments, you need to commit the changes. You can do
this by pressing the Apply button that appears in the Tool Options Bar or by pressing the
enter key. You can cancel a transform by pressing the Cancel button in the Tool Options
Bar or by pressing the escape key.

The Trim Tool Options Bar

Using Color Fill Layers
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Color Fill Layers provide fast, re-editable ways to alter the brightness,
contrast and color of your image. Color Fill Layers leverage the power of
layers, blending modes, and opacity. Color Fill Layers are simply layers
filled with a solid color. However by changing the color, blending mode,
and opacity along with Perfect Layer's masking tools you can do the
following:

Before

After

Create a burn or dodge layer to selectively lighten or darken the
image.
Convert the image to black and white.
Tint the image any color.
Add a vignette.
Simulate photographic filters like warming and cooling.
Create darkroom looks like sepia toner.

Creating Color Fill Layer
To create a Color Fill Layer, press the Fill button in the Layers Pane or
use the New Color Fill Layer command from the Layers menu. The Color
Fill Layer dialog will appear. With this dialog you can select a preset or
manually adjust the color, blending mode, and opacity of the Color Fill
Layer.
1. Preset: This pop-up list contains presets for many common filter
effects. Select a preset from the menu to preview it on your
image.
2. Fill Color: This is a color well that displays the current color. You
may press the color well to open a color picker dialog. Selecting
new colors in the color well will be previewed in realtime on the
image.
3. Blending Mode: This option sets the blending mode for the
layer. You can always change this later from the Layers pane.
4. Opacity: This slider sets the opacity for the layer. You can think
of this as a strength slider for the effect. You can always
change this later from the Layers pane.

Editing a Color Fill Layer
You can edit an existing Color Fill Layer by using the Edit Color Fill Layer
option from the Layers menu. It will reopen the Color Fill Layer dialog
where you can adjust the settings.
Color Fill Layers work similar to a regular layer. You can move, resize,
rotate, trim, delete and duplicate them.

Masking a Color Fill Layer
You can mask, or selectively apply a Color Fill Layer using any of the
masking tools in Perfect Layers, similar to any other layer. To learn how
to mask a layer, see the Masking Layers section.

Perfect Eraser
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The Perfect Eraser can be used to remove distracting elements and blemishes from your image.

How it Works
The Perfect Eraser employs a content aware
algorithm that replaces the pixels with a natural
and plausible result within the boundaries that are
painted.

Using the Perfect Eraser
Activate the tool by selecting it in the Tool-Well. Simply paint over the area you wish to remove. Make sure you cover the entire area. A red overlay
appears where you paint. You can adjust the size of the brush using the Tool Options bar.
If the first attempt does not give you a perfect result, simply paint over it again and it will improve with each pass. You can also fine tune the area after
using the Retouch Brush.

Retouch Brush
Retouch Brush: Use the Retouch Brush to remove small imperfections like dust or blemishes. Just dab the retouch

brush on spots like acne, dust spots, power lines, etc. It looks at the neighboring areas and fills in the brush with
similar color and texture. It is best to use the smallest brush size possible and to work by dabbing rather than making
large brush strokes. If you dab with the Retouch Brush and don't like the results, use the undo command and try using
a smaller brush or vary your brush stroke and try again. The Retouch Brush is perfect for retouching skin.

You can control the Retouch Brush using the Tool Options Bar:

Brush Size: This adjusts the overall size of the brush.
Brush Feather: This adjusts the hardness of the brush. It
works best to use a feather larger than 50 to blend and look
natural.
Brush Opacity: This adjusts how strong the retouching is.
Use 100% to completely remove an imperfection. Use a lower
opacity to soften them.
W: If you have a Wacom pressure sensitive tablet, you can
adjust the size of the brush according to the pressure. Click
on the "W" in the box to activate the Wacom
sensitivity controls.
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Clone Stamp
Clone Stamp: Use this tool for replacing an area of the image with a sample area from a different part of the image.

This will allow you to select an area to clone. Hold down the option (Mac) or alt key (Win)
and click the area you want to clone from.
Then click and drag on the area you want to clone over and it will clone from the point you
selected.
You can adjust the size of brush, feather and opacity just as you would with the regular
brush. This just gives you more control over the area you want to retouch.
Tool Options Bar

Red-Eye Tool
Red-Eye Tool: To instantly reduce red-eye.
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The Red-Eye Tool is the perfect tool for eliminating or reducing red eye
in your images. It's a simple one-click stamp that will immediately take
care of red eye.
You start by selecting the red eye brush in your Tool-Well. Next adjust
your brush size to be as close to the same size as the red eye you are
wanting to remove. Then place the brush right over the eye and click
once to remove.
The Protect Skin toggle reduces the tools affect on skin colored areas.
It is on by default. If the red-eye reduction is not strong enough, try
toggling this off.

Using the Masking Tools
Masking is a technique or technology used to solve many problems. Rarely is creating a mask the end goal of masking. You use masking to combine images and
exposures, swap heads, replace skies and add effects to portions of an image.
Perfect Layers users can choose from a fleet of mask creation and refinement tools. This opens a whole new world of control and creative options. Using the
masking tools is just like using a layer mask in Photoshop to hide or reveal a layer or filter in specific, user-defined areas of the image. The Masking tools even
support pressure-sensitive Wacom tablets for the ultimate in control.
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You can think of masking as painting with black paint on white
paper.
A white mask reveals all the layer (or filter) that the mask is
attached to. An all white mask is considered blank or empty and
shows all the selected layer. As you use the masking tools, you
are adding black paint (Paint-Out mode). Where you paint with
black you are hiding the current layer, allowing the layers under
it to show through. Think of it like cutting a hole in the mask. If
you make a mistake, you can switch your paint color to white
(Paint-In mode) and paint the layer back in like an eraser.
When you paint you have more than just white or black, but
any shade of gray in between depending on the opacity of the
tool. Shades of gray partially hide the layer, blending the layers
together.
Each layer in Perfect Layers or filter layer in Perfect Effects has
a mask automatically added to it. This allows you blend each
layer differently.
There are several global masking options that can be accessed
from either the masking Tool Option Bar or the Masking Menu.
They affect the entire mask on the selected filter layer.

Reset Mask
Reseting a mask returns it to all white. The entire layer is
visible.

Invert Mask
Invert swaps the white for black and black for white. What was
hidden is now revealed and vice-versa. Inverting a mask can be
very useful. It allows you to paint a layer in, rather than out,
which is handy if you only want to work with a small area.

Copy and Paste Mask
You to copy the mask from one layer to another. This is handy
if you have painted a complex mask on one layer for an
adjustment and you wish to use the same mask on another
layer for a different adjustment. To copy or paste a mask, use
the Copy Mask and Paste Mask commands from the Masking
menu. You can even copy and paste masks between Perfect
Layers and Perfect Effects.

Luminosity Mask
A luminosity Mask is based on specific tones derived from the
image. Great for blending layers selectively based on the
brightness of the image.

Paint-In Effects
Some of the filters in Perfect Effects are designed to be painted-in. When you add them to your
image, you will not see the image change, but the Masking Brush will be selected automatically.
Simply paint where you would like the filter to be applied.
You can identify Paint-In filters by the paint-brush icon in the upper left corner of the thumbnail.
Most of the Paint-In filters are located in the Basic Brushes category.

Mask Preview Modes
Mask preview modes allow you to view your mask in several ways.
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The drop-down menu for Mask View Mode is located at the bottom of
the Preview Window.

A close-up of the Mask View Modes

Before: Shows the original image with no effects applied.
After: Shows the image with the current effect stack applied.
Previous Effect: Shows the previous effect results so you can compare
just your current effect.
Mask-Red: Shows the mask of the current effect layer in a red overlay.
Mask-White: Shows the mask of the current effect layer in white.
Mask-Dark: Shows the mask of the current effect layer in as a dark
overlay.
Mask-Grayscale: Shows the mask of the current effect layer in black
and white.

Mask View allows you to view the mask for each effect layer that you have created with the Masking Brush and Masking Bug. You can view the mask in
several modes, which are accessible from the Masking menu or from the Mask View drop-down in the bottom left of each preview pane. Below are
examples of the different mask view modes. You can toggle the mask view on and off with the control (Mac OSX) or control (Windows) + M keyboard
shortcut.

Mask-Red
The masked area appears
as 50% red. This is similar
to the Quick Mask view in
Photoshop.

Mask-Dark
The masked area appears
as 90% black.

Mask-White
The masked area appears
as solid white.

Mask-Grayscale
The masked area appears
as black. The unmasked
areas appear as white. This
is the same as viewing a
layer mask in Photoshop.

Using the Masking Brush
The Masking Brush: The Masking Brush functions like a brush tool for masking layers.

The Masking Brush is one of two tools in Perfect Effects for masking
filters. When you select the Masking Brush, your tool icon changes to a
circle that represents the size of the brush. It may also appear as two
concentric circles (see below), indicating the inner hard edge and outer
soft edge of the brush if the feather control is set above zero. There is
also either a plus or minus in the center of the brush. Minus means the
brush mode is set to paint-out, plus means it is set to paint-in.
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How to use the Masking Brush
To use the Masking Brush, select it in the tool well. Make sure you are on the effect you wish to hide. Then check your brush mode and confirm it is set to
Paint-Out. You are ready to mask now, simply paint on the image in the areas you wish to hide. As you brush, you will see the underlying effect(s) appear.
If you make a mistake while brushing you have several options to correct them:
First you can use the Undo command from the edit menu. This will undo the last brush stroke you created.
You can toggle the paint mode to Paint-In and brush over your mistake.
How to control the Masking Brush
The Masking Brush Tool Options Bar

Paint Mode
The paint mode controls is you are Painting-Out (hiding the effect) or Painting-In (restoring the effect). You can tell your current mode by looking at the plus
or minus icon in the center of the brush. If the icon is minus, you are painting out. If the icon is a plus, you are painting-in. You can change the mode in the
Tool Options Bar, or by pressing the X key, or by holding down the option (alt) key temporarily.
Invert Mask
Invert swaps the hidden areas for the visible areas. What was hidden is no revealed and vice-versa. Inverting a mask can be very useful. It allows you to
paint a layer in, rather than out, which is handy if you only want to work with a small area. You can invert the mask by pressing the Invert button in the
Tool Options Bar.
Reset Mask
Reseting a mask reveals the entire layer it is associated with. You can reset the mask by pressing the Reset button in the Tool Options Bar.
Erase Brush Strokes
This is a special mode used when retouching the mask created by a Masking Bug. It allows you to erase your brush strokes made with the Masking Brush
while maintaining the mask from the Masking Bug.
Brush Size
You can control the size of the brush using the Size pop-up in the Tool
Options Bar. You use a small brush at high magnification for precise
work, and a large brush at fit to screen for general work. To the right,
you can see examples of brush strokes at varying sizes. You can control
the size of the brush several ways:
Use the Size pop-up in the Tool Options Bar.
Use the left and right bracket keys ( [ ] ).
Use the mouse scroll wheel (preferences must be set to this).
Use your Wacom pressure sensitive tablet.

Feather
You control the amount of feathering or hardness of the brush by using
the Feather pop-up in the Tool Options Bar. The feather has a range
from 1 to 100 percent. You use a small feather at high magnification for
precise, hard-edged work and a large, soft-edged brush at fit to screen
for general work. You can visually see your feather by watching the
outer concentric circle of the brush tool. To the right you can see
examples of different feather options. You can control the size of the
brush several ways:
Use the Feather pop-up in the Tool Options Bar.
Use the shift + left and right bracket keys ( [ ] ).

Perfect Layers

40 Perfect Layers

Opacity
You can control the opacity, or strength of the brush with the Opacity
pop-up in the Tool Options Bar. Think of the opacity as the shade of
gray you are painting with. The opacity has a range from 1 to 100
percent. You use a high opacity to paint quickly and hide large areas.
You use a lower opacity for blending areas together or for subtle work.
To the right you can see examples of different opacity options. You can
control the size of the brush several ways:
Use the Opacity pop-up in the Tool Options Bar.
Use the option (Mac OSX) or alt (Windows) + 0-9 keys.
Use your Wacom pressure sensitive tablet.

Wacom® Controls
Perfect Layers supports pressure sensitive Wacom tablets. When you
use the Masking Brush you can enable pressure sensitive controls for
the brush size, brush opacity, or both simultaneously. Click on the W
button next to each control in the Tool Options Bar to activate the
pressure sensitive controls.
The harder you press; the greater the size or opacity will get. You can
set the maximum value you want to use the Brush Size and Opacity
sliders. To the right you can see examples of how pressure sensitivity
can be used to control the Masking Brush.

Perfect Brush
The Perfect Brush option enables a unique, color-based, self masking
technology. When enabled, as you paint with the Masking Brush it
collects the colors under the center of the brush and only masks those
colors. This protects the mask from being applied across edges. A great
of example of using the Perfect Brush option would be to mask a sky
along a horizon of mountains.
Tip: You can turn the Perfect Brush on and off using the
command or control -r keyboard shortcut. You can also
temporarily lock the color to remove by holding down the
control key(win) or the command key(mac). This is useful when
brushing through areas with a lot of openings like tree
branches.

Quick Mask Tool
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Quick Mask Tool: Used to mask large similar areas quickly.

The Quick Mask Tool is often the best place to start your masks. It automatically masks large similar
areas without the need to brush over everything. You just need to brush loosely over what you
want to mask to give it a hint. It then figures out the rest on its own.
To use the Quick Mask Tool follow these steps:
1. Select the Quick Mask Tool from the Tool-well.
2. Make sure the tool mode is set to Paint Out.
3. Loosely brush over the area you want to mask. This could be a background

you want to remove or a sky or an area you want to remove an effect from.
When you release the mouse button the area is automatically expanded and
masked. In simple cases your work may be done.
4. Continue to brush over the area you want to mask in areas that where not automatically
removed. You can also try the Grow button. Stop brushing when you get to difficult areas
like hair.
5. Use the Refine Brush over difficult areas like hair to refine your mask.

Below are descriptions of the controls in the Quick Mask Tool Options Bar.

Mode: Controls whether you want to paint out (mask) or paint in (restore). Generally you will use the paint out mode.
Size: Sets the size of the tool.
Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain parameters with pressure. Controls with a W icon next to them
support this when they are turned on.
Box Tool: The box tool allows you to drag a box over your subject, then press return to remove anything outside the box.
Grow: Intelligently expands the mask to include more similar regions.
Invert: Inverts or flips the mask so that what was hidden is now revealed and vice versa.
Reset: Resets the mask to all white.

Box Mode

Perfect Layers

42 Perfect Layers

The Quick Mask Tool is generally used as brush but it has a second option called Box Mode. Box
mode is perfect for when your subject is isolated and not touching the edges of your image. To
enable Box Mode, select the Box tool in the tool options bar. Then drag a box over your subject.
You can adjust the size and position of the box using the corner handles. Then hit the return key to
automatically remove anything outside of the box and anything similar from inside the box.

Using the Masking Bug

Masking Bug: This is used for blending layers by creating Radial, gradient, and reflected gradient mask shape quickly.

The Masking Bug is perfect for tasks like darkening skies, creating vignettes and graduated filters. Learning to use the Masking Bug is fast and easy. All the
adjustments made with the Masking Bug are live and readjustable until you press apply.

Masking Bug Tool Options

The Tool Options Bar for the Masking Bug includes the options shown above and detailed here:
Preset: The preset pop-up includes several common ways to use the Masking Bug. These presets change the current Masking Bug to match the preset
Shape: The shape pop-up controls the shape of the Masking Bug. The shapes are center, edges, gradient and reflected gradient.
Opacity: Sets the maximum opacity or density of the mask.
Add: Adds a new Masking Bug using the current settings.
Delete: Deletes the current Masking Bug
Reset: Resets the mask on the layer completely. This removes all Masking Bugs and clears and brushing that has been done.
Adjusting the Masking Bug
Start by adding a Masking Bug to a layer by clicking on it or pressing the Add button. Then set the Mask View mode to Mask - Grayscale. This will let you
see the Masking Bug in simple black and white.
Move: Click the large circle and drag.
Size: Adjust the size of the masking bug by using the solid line
Feather: Use the dashed line to adjust the feather or hardness of the mask.
Rotate: The handle of the center circle will rotate the mask.
Reflected Gradient
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Center

Edges

Working with Multiple Masking Bugs
You can use up to six Masking Bugs per layer. Each Masking Bug is re-editable
until you hit Apply and save your image. To add another Masking Bug, to create
a complex mask shape, press the Add button or click outside of the current
Masking Bug while the Masking Bug tool is selected.
Only one Masking Bug may be adjusted at a time. This is the active Masking Bug.
You will see the overlay controls for the active Masking Bug while your mouse is
over the preview area. Inactive Masking Bugs are marked with a small circle. You
can select an inactive Masking Bug by clicking on this small circle marker.
Masking Bugs are subtractive. Each Masking Bug hides more and more of the
current layer. When Masking Bugs overlay each other they may hide more of the
layer too. You can always use the Masking Brush to over-ride and paint areas
back in hidden by the Masking Bugs.

Using the Line Mask Tool

Line Mask Tool: This tool is used to mask strait lines.

The line mask tool works great for creating linear masks that are strait sided and can include angles but not for curves.
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Line Mask Tool Options

Using the Line Mask T

Begin by selecting the too

Mode: Add/Remove
Feather: Adjusts the feather of mask i.e. the hardness of the line transition from black to white.

Refining Masks
Perfect Layers
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There are several tools in Perfect Layers that may be used to refine or clean-up a mask.

Refine Brush: This tool cleans up intricate areas and the borders between the Keep and Drop Brush.

The Refine Brush is used to clean up the borders between the subject and background as
well as intricate areas like hair, lace, mesh and tree branches. Once you have removed the
majority of the background with the Quick Mask Tool or Perfect Brush, paint the
intersection of the subject and background to refine the border. This will remove islands of
background color and make the edge more defined.

Refine Brush Tool Options

Mode: Controls the refinement mode, either paint out, which always refines to remove, paint in, which always refines to restore or Auto which does both
at the same time. Paint out is recommended in most cases.
Size: This slider adjusts the size of the brush. Select a brush size that is just larger than the intersection of the subject and background. Avoid using
oversized brushes it will take longer to process and may yield lower quality results.
Wacom Toggle: If you have a Wacom pressure sensitive tablet you can control certain parameters with pressure. Controls with a W icon next to them
support this when they are turned on.
Color Decontamination: When enabled, colors from the drop regions are filtered out of the keep regions. This changes the colors of the pixels in the
image. This is useful when the background you are trying to remove have a strong color such as green or blue screens.

The Chisel Mask Tool:The Chisel tool is used for removing fringes or halos along hard edges.
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Fringes are common when the background to be removed is brighter than the foreground.
The chisel works like a chisel or plane in a wood shop. It removes just a sliver along the
edges. The chisel tool only works on the edges so you don't have to be careful with it.

Chisel Mask Tool Options

Mode: Select remove or restore.
Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. The size of the chisel does not affect how much is chiseled
off.
Amount: Controls the amount, or depth of the chisel. Use the lowest amount needed to maintain as much detail as possible.
Tip: You can double-click on the chisel tool icon in the tool well to apply the chisel to the entire image.

The Blur Mask Tool: Softens edges where you paint.
Softening the edges on blurred or semi-transparent subjects like hair can make them blend
with a new background in a more realistic manner. The blur tool only works on the edges
so you don't have to be careful with it

Blur Mask Tool Options
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Mode: In/Out/Normal lets you adjust exactly what part of the mask edge to blur.
Size: Adjusts the size of the blur tool. Feel free to use a large size to make brushing fast. The size of the brush does not affect the blur amount.
Amount: Controls the amount of blur. Use the lowest amount needed to maintain as much detail as possible.
Tip: You can double-click on the blur tool icon in the tool well to apply the blur to the entire image.

Mode: Select remove or restore.
Size: Adjusts the size of the chisel tool. Feel free to use a large chisel to make brushing fast. The size of the chisel does not affect how much is chiseled
off.
Amount: Controls the amount, or depth of the chisel. Use the lowest amount needed to maintain as much detail as possible.
Chisel Hardness: Adjusts how sharp the edge created by the chisel is. The higher the amount, the softer the edge.

Menus
Perfect Layers (Mac OS X Only)
About Perfect Layers: Opens the about box, displays your version
number and activation code. (Help menu on Windows)
Preferences: Opens the preferences dialog. (Edit menu on Windows)
Quit: Quits.

File Menu
New: Opens the create new file dialog for creating a new file.
Open: Opens the open dialog for locating and opening an existing file.
Add Layer(s) from File: Opens the open dialog for location files to
merge into the current open file.
Open Selected from Browser: Opens the images selected in the
browser.
Browse Folder: Fly-out sub-menu of sources to Browse. You can also
opens the browse dialog where you can select which folder you would
like to browse in a new browser tab.
Browse Extras: Switches the browser to the Extras tab where you can
view and open website content.
Manage Extras: Opens the Extras Manager where you can import and
manage extras like Borders, Backgrounds, Textures and Presets.
Open Recent: Displays a list of recently opened files.
Close: Closes the current file. You will have the opportunity to save or
not.
Close All: Closes all open files. You will have the opportunity to save or
not.
Save: Saves the current file.
Save As: Opens the Save As dialog where you can select the filename
and location to save to.
Revert to Saved: Reopens the file without your changes.
Batch: Opens Perfect Batch window.
Print: Allows you to print your image.
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Edit Menu
Undo: Undoes the last action.
Redo: Redoes the last undone action
Copy: Disabled.
Paste: Disabled.
Rename: Renames the selected file or folder in the browser tab.
Delete: Moves the selected file or folder in the browser tab to the
trash.
Add Subfolder: Adds a new empty folder inside the selected folder in
the browser tab.
Adjust Canvas Size: Opens the canvas size dialog where you can
adjust the canvas size.

Layer Menu
Duplicate: Duplicates or copies the current layer.
Delete: Deletes the current layer.
Copy Layer: Copies the current layer into memory so you can paste it
later.
Paste Layer: Pastes the layer in memory into a new layer in the
current image.
Merge Layers: Merges the selected layers into a single layer.
Merge All: Merges all layers into a single layer.
New Stamped Layer: Creates a new layer above the current layer
that contains a merged version of all the layers under it.
Hide Other Layers: Toggles the visibility off of all layers except the
current one. Makes it easy to see just the current layer.
New Color Fill Layer: Adds a new color fill layer.
Edit Color Fill Layer: Opens the color fill layer dialog where you can
set the properties of the selected color fill layer.
Convert to Smart Layer: Allows you to change your layer to a smart
layer.

Masking Menu
Invert Mask: Inverts the mask. Visible areas become hidden and
hidden areas become visible.
Reset Mask: Resets the mask to plain white.
Copy Mask: Copies the mask from the current layer.
Paste Mask: Pastes the mask in the clipboard to the mask on the
current layer.
Create Luminosity Mask: Creates layer mask based off of the
photos tonal values.
Masking Bug Tool Opacity: Sets the opacity of the Masking Bug tool
cursor.

View Menu
Zoom In: Adjusts the preview zoom in one increment, makes the
preview image larger.
Zoom Out: Adjusts the preview zoom out one increment, makes the
preview image smaller.
Fit to Screen: Sets the zoom to fit the entire image on screen.
Actual Pixels: Sets the zoom to 100% or actual pixels.
Show Browser Pop-up: Enables the browser pop-up window.
Browser Mode: Allows the user to select how the Browser Library
displays the categories.
Show Clipping: Shows the clipping overlay view, which overrides the current mask view.
Preview Mode: Allows the user to switch preview modes.
Preview Background Color: Toggles the background color
options.
Show Mask: Allows the viewer to see the mask.
Mask View Mode: Allows the user to select the various mask modes.
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Window Menu
Navigator/Loupe/Histogram: Opens and closes the Navigator
pane.
Layers: Opens and closes the Layers pane.
Open Quick View Browser: Opens the Quick View Browser window,
displaying the contents of the current folder.
Show Browser Panel: Hides or shows the Control Panel.
Show Control Panel: Hides or shows the Control Panel.
Hide Panels: Hides or shows all Panels.
Full Screen: Toggles to and from full screen mode.
Document Name: Shows the name, zoom level and bit depth of the
open image.

Help Menu
Search: Searches the menus (Mac OSX only).
Perfect Layers Online Help: Opens this html Help in your default web
browser.
Video Tutorials: Opens the online Video Tutorial in your default web
browser.
Getting Started: Opens the online Getting Started overlay.
Show Keyboard Shortcuts: Opens the keyboard shortcut inspector.
Perfect Inspiration: Takes you to the Perfect Inspiration web site.
Check for Updates: Checks with the onOne update server to see if
you are running the current version. If there is a newer version you will
be notified and be walked through the update process.
Deactivate: Opens the activation dialog. These are used to deactivate
your software for moving it to another computer or for a return.
Registration: Opens the default web browser and navigates to the
registration page of the onOne website.
Provide Feedback: Opens the default web browser and navigates to
the feedback page of the onOne website.
Help Improve onOne Products: Opens the Improve onOne Products
dialog.

Keyboard Shortcuts
Action

Mac

Win

New File

cmd n

ctl n

Open

cmd o

ctl o

Add Layer(s) from File

cmd shift o

ctl shift o

Open Selected from Browser

cmd opt o

ctl alt o

Close

cmd w

ctl w

Save

cmd s

ctl s

Save As

cmd shift s

ctl shift s

Print

cmd p

ctl p

Exit

cmd q

ctl q

Undo

cmd z

ctl z

Redo

cmd shift z

ctl shift z

Copy

cmd c

ctl c
ctl v

Paste

cmd v

Delete File

delete

delete

Duplicate Layer

cmd j

ctl j
ctl e

Merge Layers

cmd e

Merge Visible

cmd shift e

ctl shift e

New Layer from Composite

cmd shift j

ctl shift j

Next Blend Mode

Shift +

Shift +

Previous Blend Mode

Shift -

Shift -
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Layer Opacity

1 (10%)
2 (20%)
0 (100%)
etc

1 (10%)
2 (20%)
0 (100%)
etc

Paint in/ Paint Out

x

x

Invert Mask

cmd i

ctl i

Toggle Perfect Brush

cmd r

ctl r

Brush Size

larger ]
smaller [

larger ]
smaller [

Brush Feather

softer shift ]
harder shift [

softer shift ]
harder shift [

Brush Opacity

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

opt 1 (10%)
opt 2 (20%)
opt 0 (100%)
etc

Show/Hide Mask

o

o

Zoom In

cmd +

ctl +

Zoom Out

cmd -

ctl -

Fit to Screen

cmd 0

ctl 0

Actual Pixels

cmd opt 0

ctl alt 0

Next Browser View Mode

cmd b

ctl b

Navigate Browser Selection

Arrow Keys

Arrow Keys

Open Selected Sub-dir

Right Arrow

Right Arrow

Close Selected Sub-dir

Left Arrow

Left Arrow

Preview Modes
-Single
-Left/Right
-Left/Right Shift
-Top/Bottom
-Top/Bottom Shift

cmd y
cmd l
cmd opt l
cmd t
cmd opt t

ctl y
ctl l
ctl opt l
ctl t
ctl alt t

Navigator

cmd 1

ctl 1

Layers

cmd 2

ctl 2

Open Quick View Browser

cmd up arrow

ctl up arrow

Keyboard Shortcuts

cmd shift k

ctl shift k

Transform Tool

v

v

Red Eye Tool

e

e
c

Crop Tool

c

Trim Tool

t

t

Masking Brush

b

b

Masking Bug

m

m

Quick Mask Tool

w

w

Refine Brush

f

f

Chisel Tool

k

k

Blur Tool

l

l

Perfect Eraser

q

q

Retouch Brush

r

r

Pan Tool

h

h

Zoom Tool

z

z

Rotate Crop Clockwise

opt right arrow alt right arrow

Rotate Crop Counter Clockwise opt right arrow alt right arrow
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F
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G
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I
Installation 3
Introduction 2
invert mask 36
iPhoto 11

K
Keep Brush 40
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L

Deactive 4
Deleting a Layer 28 ,28
Directory 23
Display 3
Drop Brush 40

Layer Masks 28
Layer Menu 47
Layer Visibility 28
Layers 27
Layers Pane 18
Left-Right Screen 22
Left-Right Split Screen 22
Legal 2
Licensing 4
Lightroom 8
Loupe 18 ,21

E

M

Edit Menu 47
Edit with Plug-in 10
Editing a Color Fill Layer 32
eReader 2
Export 10 ,8
External Editor 10 ,8 ,11

Mac OSX 3
Mask Modes 37
Masking a Color Fill Layer 32
masking brush 36 ,18 ,19
masking bug 36 ,18 ,19

D

Masking Menu 47
Masking tools 36
Masks 18
Menus 47
Merging Layers 28
Module Selector 6
Moving a Layer 29
Moving the Trim Box 32

N
Navigating the Preview Window 18
Navigator 18 ,21

O
onOne Panel 7
onOne Software 2
onOne University 3
OpenGL 3
Opening 5

P
paint in effects 36
Pan Tool 19
paste mask 36
PDF 2
Perfect Layers 6
Phone 2
Photoshop 7
Photoshop Elements 7
Plug-In Extras 8
PNG 5
Preview Window 18
Preview Window Modes 37 ,22
Printing 2
PSB 5
PSD 5

R
RAW 5
Refine Brush 40
Registration 4
Renaming Layers 28
reset mask 36
Resizing a Layer 29
Resizing a Trim Box 32
Retouch Brush 18 ,19
Rotating a Layer 29

S
Save As 5
Saving 5
Single Mode Screen 22
Standalone 7
Support 2
Support File Types 5

System Requirements 3

T
Tablet 2
The Layers Pane 28
The Trim Inspector 32
TIF 5
Tool Well 18 ,19
Top-Bottom Screen 22
Top-Bottom Split Screen 22
Transform Tool 18 ,19
Transforming Layers 29
Trim Tool 18 ,19 ,32
Trimming Layers 32

U
Uninstalling 3
User Guide 18 ,1
User Interface 18
Using Color Fill Layers 32
Using Modules 6
Using Perfect Layers 26
Using the Help System 2
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V
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View Menu 47

W
Webinar 3
Window Menu 47
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Z
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